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Introduction
Single Account Plan is a tool that allows you to classify your company’s accounts 
according to the structure defined in the Single Account Plan for businesses. You 
can thus standardize the financial reports of the company as required by the legal 
authorities.

Be sure to install Crystal Reports version 10.0 on your system to successfully generate the 
reports.

Check for current instructions
This information was current as of February 2007. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most 
current documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Single Account Plan, and how it integrates with the Microsoft 
Dynamics™ GP system.

To make best use of Single Account Plan, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Single Account Plan setup,” explains how to install and set up 
Single Account Plan for your company.

• Chapter 2, “Reports,” explains how to generate the financial reports for your 
company in Crystal Reports format.

http://go.microsoft.com/fwlink/?LinkID=79222
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.
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U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Single Account Plan setup
Use this information to set up Single Account Plan for your company. You can 
specify the segments of your account format that will be used to generate Single 
Account Plan codes. These codes allow you to classify your company’s accounts 
according to the structure defined in the Single Account Plan for businesses. You 
can thus standardize the financial reports of the company as required by the legal 
authorities.

Be sure that you have copied the Reports folder available with the installation in 
order to generate the required reports.

When you set up Single Account Plan, you can open each setup window and enter 
information, or you can use the Setup Checklist window (Microsoft Dynamics GP 
menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup 
process. See your System Setup Guide (Help >> Contents >> select Setting up the 
System) for more information about the Setup Checklist window.

This information is divided into the following sections:

• Before using Single Account Plan
• Selecting the account segments
• Viewing the generated Single Account Plan codes

Before using Single Account Plan

Before you begin using the Single Account Plan, you must set up the account format 
for the Chart of Accounts in the Account Format Setup window (Microsoft 
Dynamics GP menu >> Tools >> Setup >> Company >> Account Format). Based on 
your company’s account format setup, you can identify the account segments that 
correspond to the Single Account Plan code structure.

You must create a PUC.txt file as per the codes and account structure details 
specified by the legal authorities. Use the Table Import tool (Microsoft Dynamics GP 
menu >> Tools >> Integrate >>Table Import) to import the information from the 
PUC.txt file to the Single Account Plan account master table. Refer to the Import 
Utility documentation for more information.

Selecting the account segments

Use the Select Account Segments window to select the account segments to 
generate the Single Account Plan codes. These codes will be used to classify 
accounts while generating the financial reports.
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To select the account segments:
1. Open the Select Account Segments window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Account 
Segments)

The scrolling window displays the segment ID and segment name for all the 
segments you set up in the Account Format Setup window.

2. Mark the PUC checkbox to select the segments that will be used to generate the 
Single Account Plan codes.

3. Select the Year for which to assign the Single Account Plan codes to the 
respective accounts.

4. Choose Update to open the Single Account Plan Codes window where you can 
view the Single Account Plan codes that are generated. Refer to Viewing the 
generated Single Account Plan codes on page 6 for more information.

5. Choose Process to assign the generated Single Account Plan codes to the 
respective accounts.

Viewing the generated Single Account Plan codes

Use the Single Account Plan Codes window to view the Single Account Plan Codes 
that correspond to each account that you have set up. These codes are generated 
based on the structure defined in the PUC.txt file and the account segments that you 
selected in the Select Account Segments window. Refer to Selecting the account 
segments on page 5 for more information.
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To view the generated Single Account Plan codes:
1. Open the Single Account Plan Codes window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Account 
Segments >> Update button)

The Account Number column displays all the accounts that you have set up. 
The Single Account Plan Code column displays the Single Account Plan codes 
for the respective accounts.

2. Choose Change to return to the Select Account Segments window where you 
can select a different set of account segments if required.

3. Choose Save to save the codes and return to the Select Account Segments 
window where you can complete the process of assigning the codes to the 
respective accounts.
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Chapter 2: Reports
Use this information to generate the financial reports for your company in Crystal 
Reports format. You must have installed Crystal Reports version 10.0 to successfully 
generate the reports.

Be sure to run the account reconciliation process (Microsoft Dynamics GP menu >> 
Tools >> Utilities >> Financial >> Reconcile) for the year before generating the 
reports for that year. Refer to the General Ledger documentation for more 
information on the reconciliation process.

This information is divided into the following sections:

• Adding the report templates to the shortcut bar
• Level of Accounts - overview
• Printing the Inventory and Balance book reports
• Printing the Journal book reports
• Printing the Balance and Ledger book reports

Adding the report templates to the shortcut bar

You must add the Crystal Reports templates that you copied during installation to 
the Microsoft Dynamics GP shortcut bar, before you can generate the financial 
reports. You must add the following report templates to the shortcut bar.

• LibInven7SQL.rpt
• libro diario7SQL.rpt
• libro diario7SQLHistory.rpt
• libro diario7SQLOpen.rpt
• MayorBal7SQL.rpt

To add the report templates to the shortcut bar:
1. Open the Add External Shortcut window.

(Shortcuts >> Add >> External Shortcut)

2. Enter a name for the report in the Name field. The name can be up to 79 
characters long and will appear in the shortcut bar. Be sure to enter a name to 
easily identify the report with.

3. Choose the Browse button to locate the report to add. The Select an Application 
window appears.

4. Select the LibInven7SQL.rpt within the Inventory and Balance folder of the 
Reports folder that you installed. Choose Open to add its path to the Command 
Line field in the Add External Shortcut window.

5. Choose Add to create a shortcut to the selected report.

6. Repeat steps 3 through 6 to add the libro diario7SQL.rpt, libro 
diario7SQLHistory.rpt, and libro diario7SQLOpen.rpt from the Journal book 
folder, and the MayorBal7SQL.rpt from the Balance and Ledger book folder 
respectively to the shortcut bar.

7. Choose Done to close the Add External Shortcut window.
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Level of Accounts - overview

While generating reports, specifying the levels of accounts allows you to view the 
cumulative balances for groups of accounts. The levels of accounts are based on the 
PUC code for the account. The first digit from the left of the PUC code of an account 
is the level 1 for that account. The first two digits from the left make up level 2, and 
so on. You can select to print the report for level 1. Subsequently you can generate 
reports for even levels, for example level 2, level 4, level 6, and so on, up to twenty 
levels of accounts.

The following table displays how the account levels are determined based on the 
PUC codes:

While generating reports for the above codes, the reports will display the 
cumulative balances for the accounts depending on the level.

Printing the Inventory and Balance book reports

Use this information to print the Inventory and Balance book reports for an open 
year or a historical year. You must have added the report window to the Shortcut 
bar. Refer to Adding the report templates to the shortcut bar on page 9 for more 
information.

PUC Codes Level 1 Level 2 Level 4

1100 00 000 1 11 1100

1100 01 000 1 11 1100

1100 02 000 1 11 1100

1274 00 000 1 12 1274

1200 00 000 1 12 1200

2101 00 000 2 21 2101

2120 00 000 2 21 2120

2275 00 000 2 22 2275

4121 00 000 4 41 4121

4520 01 000 4 45 4520

Account level 
selected

Cumulative balance of accounts

1 Cumulative balance for all codes starting with the digit 1

Cumulative balance for all codes starting with the digit 2

Cumulative balance for all codes starting with the digit 4

2 Cumulative balance for all codes starting with the digits 11

Cumulative balance for all codes starting with the digits 12

Cumulative balance for all codes starting with the digits 21, and so 
on.

4 Cumulative balance for all codes starting with the digits 1100

Cumulative balance for all codes starting with the digits 1274

Cumulative balance for all codes starting with the digit 2101, and so 
on.
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To print the Inventory and Balance book reports:
1. Open the Inventory and Balance book report window.

(Shortcuts >> Choose Inventory and Balance book)

2. Choose the Refresh button in the Crystal Reports - Inventory and Balance book 
report toolbar to open the Enter Parameter Values window.

3. Enter the Period for which to generate the report in the Discrete Value field. 

4. In the Parameter Fields, select Company. Enter the name of the company for 
which to generate the report in the Discrete Value field.

5. Select Year in the Parameter Fields. Enter the year for which you have processed 
the transactions in the Discrete Value field.

6. Select Level of Accounts in the Parameters Fields. Enter the level of accounts for 
which to view the report in the Discrete Value field.

7. Choose OK to open the Data Source Selection window and select the Data 
Source Name for the server you are connected to.

8. Choose Next to open the Connection Information window and select the 
database you are connected to.

9. Choose Finish to print the Inventory and Balance book report.

Printing the Journal book reports

Use this information to print the Journal book reports for an open year, a historical 
year, or for both open and historical years. You must have added the report window 
to the Shortcut bar. Refer to Adding the report templates to the shortcut bar on page 9 
for more information.

To print the Journal book reports:
1. Open the Journal book report window.

(Shortcuts >> Choose Journal book)
(Shortcuts >> Choose Journal book for historical years)
(Shortcuts >> Choose Journal book for open year)

2. Choose the Refresh button in the Crystal Reports - Journal book report toolbar 
to open the Enter Parameter Values window.

3. In the Parameter Fields, select Initial Date. Enter the starting date for which to 
generate the report in the Discrete Value field.

4. In the Parameter Fields, select Final Date. Enter the ending date in the Discrete 
Value field.

5. Select Company in the Parameter Fields. Enter the company in the Discrete 
Value field for which to generate the report.

6. Choose OK to open the Data Source Selection window and select the Data 
Source Name for the server you are connected to.
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7. Choose Next to open the Connection Information window and select the 
database you are connected to.

8. Choose Finish to print the Journal book report.

Printing the Balance and Ledger book reports

Use this information to print the Balance and Ledger book reports for an open year 
or for a historical year. You must have added the report window to the Shortcut bar. 
Refer to Adding the report templates to the shortcut bar on page 9 for more information.

To print the Balance and Ledger book reports:
1. Open the Balance and Ledger book report window.

(Shortcuts >> Choose Balance and Ledger book)

2. Choose the Refresh button in the Crystal Reports - Balance and Ledger book 
report toolbar to open the Enter Parameter Values window.

3. Select Year in the Parameter Fields. Enter the year for which you have processed 
the transactions in the Discrete Value field.

4. Enter the Period for which to generate the report in the Discrete Value field. 

5. In the Parameter Fields, select Company. Enter the name of the company for 
which to generate the report in the Discrete Value field.

6. Select Level of Accounts in the Parameters Fields. Enter the level of accounts for 
which to view the report in the Discrete Value field.

7. Choose OK to open the Data Source Selection window and select the Data 
Source Name for the server you are connected to.

8. Choose Next to open the Connection Information window and select the 
database you are connected to.

9. Choose Finish to print the Inventory and Balance book report.
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Glossary
Single account plan code

The value that is generated based on the 
account segments you select. It allows you to 
classify your company’s accounts according 
to the structure defined in the Single 
Account Plan for businesses.

Account segment
A portion of the account format that can be 
used to represent a specific aspect of a 
business. For example, accounts can be 
divided into segments that represent 
business locations, divisions or profit 
centers.

Level of accounts
An arrangement that allows you to view the 
cumulative balances for a group of accounts 
based on their PUC codes.
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